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Introduction
LincView OPC is a software application that allows Data-Linc Group SRM family radio users to monitor radio performance
and troubleshoot their multi-point network. LincView OPC allows you to easily detect problems with one or more radios on
your network and to remotely make modifications to any radio on the network. Eliminating the time it takes to travel to the
radio and to make changes to the radio’s configuration. Users can select from several different options to determine when a
warning or an alarm will be created to alert the user there is a problem with one or more radios.

Requirements
To use LincView OPC, you need a computer able to access the Data-Linc Group radio network. The computer may be an
additional computer; or it may be the computer already connected to the Data-Linc Group radio network’s Master radio (as
long as it has an extra RS-232 port available, and it can run LincView OPC simultaneously).
The diagnostic computer’s operating system must be Windows (’98 or NT 4.0 or later).
Your computer may use the following options to access the Data-Linc network.
• A serial port connection in the back of your computer
• An Ethernet network using UDP/IP
• A Terminal Server and a network (LAN, Internet,…) using TCP/IP
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Installing LincView OPC
LincView OPC comes with an installation wizard. To install LincView OPC, follow these steps:
1) Locate the file “LincView.exe. and double click on it to run the setup wizard. The actual screens you see may
vary depending on your version of the Microsoft Windows operating system. The following screens appear for
Windows XP Professional:

2) Click on the Next button.

3) Enter your Full Name and Organization. Choose who on this computer will use LincView OPC then click on the
Next button.
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4) Select a Destination folder to install LincView OPC by clicking on the Browse button or use the default folder.
Click on the Next button.

5) Click on the Next button to begin installation.
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6) LincView OPC begins updating your computer by initializing and installing the software.

7) Click on the Finish button.
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Connecting Radios to Your Computer
To establish a connection between LincView OPC and your network, you must connect the radios to your computer. Since
each Data-Linc radio network varies in complexity, the connection type you select will vary. If you need assistance
determining the best connection type for your network, call Data-Linc's Technical Support for assistance.
Depending on the method you want to use to connect to LincView OPC, you will need to follow the steps in the appropriate
section below.

Serial Port Connection
The Serial Port connection type can be used with either a Serial or Ethernet Master radio.
To establish a connection from your network to your computer, follow the steps below.
1. Plug in both ends of the electrical connection Data-Linc has supplied to you. The electrical connection has a
rectangular end that goes into the radio and an electrical connection to plug into an outlet.
2. Plug in both ends of the diagnostic cable Data-Linc has supplied to you. The diagnostic cable plugs into your
radios diagnostics port and into the Serial Port on your computer.
The Computer can use any of its Serial Ports (COM1 to COM8) to connect to the Data-Linc network. The default in LincView
OPC is COM1.

TCP/IP Connection
The Serial Port connection type can be used with either a Serial or Ethernet Master radio. This connection type requires an
additional device called a Terminal Server. This device is an Internet server with one or more RS232 serial ports on one end
and an Ethernet port at the other end. Data-Linc will need to provide you with a Diagnostics Cable to send diagnostics from
the Master to the Terminal Server.
To establish a connection from your terminal server to your computer, follow the steps below.
1. Connect the Master Radio to the Internet through the Terminal Server.
2. Connect the computer to the Internet.

UDP Connection
The UDP connection type can only be used with an Ethernet Master radio. This connection type is typically used in the field.
To establish a connection from your network to your computer, follow the steps below.
1. Assign an IP address to the Master Radio.
2. Assign the same IP address to LincView OPC.
3. Set the diagnostics to '129' in the setup menu.
4. Connect the Master Radio to the Ethernet network
5. Connect your computer to the Ethernet network

Modem Connection
The Serial Port Diagnostics can be connected through a dial-up modem. This connection type is used to access the master
diagnostics port from a remote location.
To establish a connection from your network to your computer, follow the steps below.
1. Setup two dial up modems, one as a Master and one as a Remote (auto-answer)
2. Connect the Master Dial-Up Modem to the PC running LincView OPC
3. Connect the Remote Dial-Up Modem to the Diagnostics Port on the Master Radio Modem
4. Set the Phone Number to Dial in LincView OPC to access the Remote Dial-Up Modem and Click Dial
PN 161-09935-001A
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Getting Started
Once you have installed the LincView OPC software and you have attached your transceivers to your computer, you are
ready to launch LincView OPC. Follow the steps below to start LincView OPC.
1. Select LincView OPC from the Program Manager in the Start menu or click on the LincView OPC icon on your
desktop. After launching the LincView OPC application, the following dialog box appears.

2. Select a network file (.NWF) from the dialog box or create a new network file by typing in a name in the File
name text box. Click on the Open button.
The following LincView OPC Network Page Appears.
Version Number -Menus -Window Tabs --

Number of Radios Connected
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Status Bar

Last Xfer

Date

Time
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Modifying a Network File Name
To rename a Data-Linc network file name, follow the steps below.
1. Select Open or New from the File menu.

2. Select a network file name by clicking on the file name in the dialog box.

3. Highlight the portion of the name you want to modify and type in the new name.
4. Deselect the file and the file name is modified.

Deleting a Network File
To delete a network file, follow the steps below.
1. Select Open or New from the File menu.
2. Highlight the network file name and press the Delete key on your keyboard. The network file name is deleted.
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LincView OPC Menu Options
There are four menu options available in the LincView OPC application:

•
•
•
•

File
Edit
Poll Radio
Help

Within each of the four menu options there are several items to select. The following describes the application menu items.

File Menu Option
Menu Item Name

Description

New

Allows you to create a new network file.

Open

Allows you to open another network file.

Close

Closes the network file currently open in LincView OPC

Import From Text File...

Imports radios from a txt file

Import From Text File...

Imports radios from a CSV file

Export to Text File...

Allows you to create a text file of the All Radio spreadsheet. This is
typically done when the user needs to send this information to Technical
Support when they need assistance.

Exit

Closes the LincView OPC application

Poll Radio Menu Option
Menu Item Name
Serial Number dialog box

Description
This option allows you to add a specific radio to your network list. When
you select this option the Serial Number dialog box appears.

Type in the Radio’s serial number and click on the OK button. The radio
will now appear in your radio network list.
Note: Do not include hyphens or other symbols in the serial number. The
serial number should contain only seven-digits.
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OPC Menu Option
Menu Item Name
Options

Description
Displays available options for OPC server operation. Must re-open file
for changes to take place.

Help Menu Option
Menu Item Name

Description

Contents

Comming Soon

Search for Help On...

Comming Soon

About

Brings you to the Home Page tab in the LincView OPC application
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Home Page Tab
The Home tab is the window that displays when you launch LincView OPC. The Home tab displays the version of LincView
OPC you are running and it has several links at the bottom of the tab. These links bring you to other tabs within LincView
OPC that are commonly used.

The following describes each of the five links.

Quick Link

12

Description

Check on the status of a radio

This link brings you to the Radio Status tab. This tab displays
information about the selected radio in graphical form.

View a tree of the radios in
the network

This link brings you to the Radio Status tab. This tab displays your
network in a tree view. This view allows you to determine the radio
communication structure of your network.

View a list of all of the radios

This link brings you to the All Radio tab. This tab displays a
spreadsheet containing a variety of information about each radio in your
network.

View a list of warnings and/or
alarms

This link brings you to the Alerts tab. This tab displays a spreadsheet
containing a list of warnings and alerts for your network.

www.data-linc.com

This links launches your Internet browser and opens the Data-Linc
Group home page.
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Alerts & Diag Settings Tab
The Alerts and Diagnostics Settings tab allows you to setup the connection to your radios. This tab also allows you to
determine when you want to be warned or alerted about specific changes to the radios in your network.
After installing LincView OPC and connecting the radios to your computer, you will need to setup your connection to the
Master radio and select your warning and alarm settings.

Programming Your Master Radio Connection
To program your Master radio connection so LincView OPC can connect to your radios, follow the steps below.
1. Click on the Alerts & Diagnostics Settings tab. The Alerts & Diag Settings tab appears. Click on the Connection
& Polling tab within the Alerts & Diag Settings tab.

2. Select the Connection to Master type. There are four connection types to choose from. For additional information
about these connection types, see the section Connecting Radios to Your Computer earlier in this document.
On the Following Page is quick reference on how setup each type of possible connections
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Connection Type

Description

Serial Port

The serial port the radio is connected to on
your computer. Use the drop-down menu to
select Com1 through Com8. This is the most
commonly used connection type with
CommControl.

TCP/IP

The Terminal Server connection. If you select
this type you will also have to enter the IP
Address and Port number. The IP address and
Port number will be the same as the Terminal
Server's IP Address and Port number.

UDP

The User Data Protocol connection. If you
select this type you will also have to enter your
IP Address, Port number and password-if you
selected a password in the radio menu. The IP
Address is the same as the IP radio address
and the Port number is always 4131.

Modem

Used for remote telephone access over a
serial dial up modem, enter the phone number
to access the serial master diagnostics port
remotely.

Note: Notice that the status bar tells you if the connection has been made or if the system is waiting for the
connection to open.
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3. Select the Temperature Units.
Unit Type

Description

Degrees F

Select this option for the system to use Fahrenheit for temperature
measurements.

Degrees C

Select this option for the system to use Celsius for temperature
measurements.

4. Select the RF Level Units.
RF Levels Type

Description

JS

Custom RF levels. This option is the default and is most commonly used
with LincView.

dB m

The global standard for RF levels.

Setting Your Alerts
LincView OPC allows you to select specific settings for the system to use to give you either a warning or an alarm. LincView
OPC comes with default settings that you may use for your alarm settings or you can modify the settings to meet your
needs.
To set your alerts, follow the steps below.
1. From the Alerts & Diag Settings tab, click on the Radio Alerts Setting tab. The following window appears:

2. There is an Alert setting window for the Master, Repeater and Slave radios. You may decide to modify one or
more of the settings or to use the default settings. You can select the settings to give you either a warning or an
alarm if the radio is above or below the number indicated.
3. Change the settings by clicking on the arrows to the right of the boxes to make the number displayed in the box
go either up or down.
4. If necessary, click on the Repeaters tab and modify the settings.
5. If necessary, click on the Slaves tab and modify the settings.
PN 161-09935-001A
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Alerts Log Tab
The Alerts Log tab displays a spreadsheet style of information about your radios. Within the Alerts Log tab you have four tabs
to select from. Each of the four tabs displays a spreadsheet style table of specific information about your radios. The
following describes each of the tabs within the Alerts Log tab.
Alerts Log Tab

Description

Alarm Log

Displays a list of all of the radios that there is an alarm on. This means
that the radio is above or below the settings you selected on the Alerts
and Diag Settings tab

Warning Log

Displays a list of all of the radios that there is a warning on. This means
that the radio is above or below the settings you selected on the Alerts
and Diag Settings Tab

Informational

Displays information about all of the radios on your network.

All Events

Displays all the information that appears in the previous three
spreadsheets.

Each of the spreadsheets displays the following radio information.
* Date/Time of the alert
* Type of alert
* Radio's call number
* Description of the alert
The following is an example of a Warnings Only spreadsheet:

At the bottom of each spreadsheet there are two buttons. Use the Clear Selected Item button to delete the highlighted row.
Use the Clear All button to delete all of the displayed rows on the spreadsheet.
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Network List View Tab
The Network List View Tab displays a spreadsheet that lists all of the radios on your network and statistics about each radio.

The Network List View spreadsheet contains a great deal of detailed information. This spreadsheet is very useful when you
are having problems with any of your radios.
You can create a text file of this spreadsheet by selecting Export To Text File from the File menu. When working with DataLinc's Technical Support, you may be asked to create a text file of your Network List View tab spreadsheet. The information
found on this spreadsheet allows Data-Linc Group’s Technical Support to better assist you.
The following describes the items displayed on the All Radios tab worksheet.
Status

Current status of the radio (e.g., alarm, warning)

Radio Name

The name of the radio, if one has been assigned.

Serial Number

The call number for the radio. This is a seven-digit unique number.

Type

The function of the radio within the network (e.g., Master, Slave or Repeater).

INoise

The inbound noise is the average level of noise the radio receives when the transmitting
radio(s) are not transmitting. This value should be a relatively small number. However, as long
as the IMargin is within 30 points the INoise is considered good.

ISignal

The strength of the inbound signal that this radio receives. For Repeaters, this refers just to
its radio link toward the Master.

IMargin

This is the spread of points between the INoise and ISignal. A spread of 30 points or less is
considered ideal.
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ONoise

The outbound noise is the average level of noise the radio receives when the transmitting
radio(s) are not transmitting. This value should be a relatively small number. However, as long
as the OMargin is within 30 points the ONoise is considered good.

OSignal

The strength of the outbound signal that this radio receives. For Repeaters, this refers just to
its radio link towards the Master.

OMargin

This is the spread of points between the ONoise and OSignal. A spread of 30 points or less is
considered ideal.

Packet

This is the percentage of data packets that this radio successfully received on the first try. If
this radio is a Repeater, this refers to the link to the Master. This value should be at least
75%.

Freq

This is the error of the radio’s radio frequency with respect to the Master. This value should be
within ± 10 ppm.

Temp

This is the operating temperature of this radio. The units displayed are either Celsius or
Fahrenheit. To select the type of unit, see the section Configuration Tab earlier in this
document. All Data-Linc Group SRM Series Radios are 100% tested for operation over a
temperature range of –40C to +75C (-40F to +167F).

Volts

This is the supply voltage of the radio modem.

Data Rate

This is the number of bytes that the radio has transferred from the end device back to the
Master. Since plain Repeaters only repeat data from another radio, their count is ‘0’. However,
if this radio is a Repeater/Slave, this count is the number of bytes that the radio has
transferred from the end device back to the Master while operating as a Slave.

Last RX

This is the time (measured using the System Clock) when this radio last replied to
diagnostics polling.

Polls

Poll is the diagnostics response rate. This is the percentage of the time that the radio
reported back diagnostics data when polled. If the radio is used to transmit a lot of data as
part of its normal operation, it will have less time to respond to the Master polling it for
diagnostics data; in that case, the diagnostics response rate will decrease. If this value is 0, it
may be because this radio is disconnected from the network.

Distance

The distance between this radio and the radio to which it is directly linked. If this radio is
linked directly to the Master, this is the distance to the Master or it is the distance to the first
Repeater that it uses.

FW Ver

The Internal Firmware version of your radio.

Data
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This is the number of bytes that the radio has transferred from the end device back to the
Master. Since plain Repeaters only repeat data from another radio, their count is ‘0’. However,
if this radio is a Repeater/Slave, this count is the number of bytes that the radio has
transferred from the end device back to the Master while operating as a Slave.
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Radio Status Tab
The Radio Status Tab allows you to select a radio to see the status graphically. This window also displays radios with a
warning or an alarm. Radios with a warning are highlighted in yellow and radios with an alarm are highlighted with red.
The following illustrates a warning in the Radio Status tab.

The following illustrates an alarm in the Radio Status tab.
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Viewing Radio Networks in the Radio Status Tab
The left side of the Radio Status tab displays all of the radios in your network. The following two options are available for you
to view your radio network.

•
•

Tree view
List view

Tree View
A tree view allows you to see your radio network in a hierarchy level. The radios indented and under one radio
communicate to the radio above it. To see your radios as a tree, select the Treeview button.
The following is an illustration of a tree view tab.

List View
A list view allows you to see all of your radios in a list format. To see your radios in a list, select the Listview button.
The following is an illustration of a list view tab.
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Viewing Radio Status Information
The right side of the Radio Status tab contains the following four tabs.
• Status
• Configuration
• Graphing
• Alerts/Warning
The following describes each of the four radio status tabs.
Status Tab
The Status tab provides a graphical interpretation of the radio you have selected in either the Treeview or Listview tab.
The yellow and red lines within the level bars indicate the warning and alarm settings you have selected. The yellow lines
indicate your warning settings and the red lines indicate your alarm settings. Therefore, if the radio is working properly
the level should appear within the yellow and red lines.
In the middle of the Status Tab there are two additional tabs: the Graphing tab and the Alerts/Warning tab. The following
describes both of these tabs.
Graphing Tab
The Graphing tab displays a graph illustrating all of the check box items you have selected around the chart.
The following is an illustration of the Graphing tab.

The Noise, Signal and Margin check boxes appear twice. If you select the check boxes above the graph, the system will
illustrate the inbound Noise, Signal and/or Margin as a solid line. If you select the check boxes below the graph, the
system will display the outbound Noise, Signal and/or Margin as a dashed line.
In addition, you may select check boxes for the following items.
•Packet
•Frequency
•Temperature
•Volts
•Data Rate
The text for each of the check boxes is in a specific color. The text color indicates the line color that item is displayed as
in the chart. You can also place your cursor over the text of the graphing item for a few seconds and a description of the
line for that item appears.
You can clear the graph and start over at any time by clicking on the Reset Graph button.
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Alerts/Warning Tab
The Alerts/Warning tab displays a spreadsheet listing all of the current radio alerts and warnings.
The following is an example of the Alerts/Warning Tab.

You can clear a row from the spreadsheet by highlighting the row and clicking on the Clear Selected Item button. Or you
can clear the entire spreadsheet by clicking on the Clear All button.
Configuration Tab
The Configuration tab displays the settings for the radio you have selected in either the Treeview or Listview tab. If there
is a problem with a radio you can modify the settings from this window.

To make a configuration change to a radio, follow the steps below.
1. Click on the Edit button.
2. Make the change to the appropriate text box by either typing over the information in the box or using the
arrows to the right of the text box to select an option or move the current number up and down.
3. When you have made all of the necessary changes, click on the Save button.
Note: If you decide you do not want to make any changes after selecting the Edit button.
Click on the Cancel button.
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OPC Server Operation
LincView OPC utilizes a standard for sharing operations operation information called OPC (OLE for Process Control). This
OPC server may be accessed by multiple OPC clients that request and receive information about radio status.

Changing OPC Server Configuration
To change OPC server settings the options dialog box must be engaged by selecting the 'Options' item from the OPC drop
down menu
The Following window will apear:

OPC Configuration Window
The OPC server name can be changed by changing the default name from LincView OPC to something that better suits
the circumstances. Keep in mind that the OPC server will register on the network using FWOPC.xxx.1 where xxx is the
name provided in the user settable text box.
If the user does not wish to allow for the OPC server to run or wishes to disable the server this may be done so by deselecting the check box that states "Start Automatically when Program Starts."
If a user wishes to have several versions of the OPC server running it may be necessary to generate a new CLSID
number. This is done by clicking the 'Generate New CLSID" button on the dialog.
Applying the settings will save all changed items to the database, however the changes will not take effect until the
network file is closed and re-opened again.
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OPC Data Availability Format
Each radio in the network is presented by the OPC server and contains 54 diagnostic tags.
Below is an example of how a default OPC server might register on an OPC client.

The following OPC data access tags are available:
Available OPC Data Access Tags
xxxxxx

xxxxxxx.HopTableSize

xxxxxxx.PPM

xxxxxxx.SignalMarginJU

xxxxxx.#OfDisconnects

xxxxxxx.HopTableVersion

xxxxxxx.PercentRcvRate

xxxxxxx.SignalOutJU

xxxxxxx.1PPSEnable

xxxxxxx.IPAddress

xxxxxxx.RFDataRate

xxxxxxx.Slave/Repeater

xxxxxxx.BaudRate

xxxxxxx.LowPowerMode

xxxxxxx.RS232/485

xxxxxxx.SlaveIPStack

xxxxxxx.DTRConnect

xxxxxxx.MCUSpeed

xxxxxxx.RTStoCTS

xxxxxxx.SlaveUDPMode

xxxxxxx.DataParity

xxxxxxx.MODBusRTU

xxxxxxx.RadioMode

xxxxxxx.TemperatureC

xxxxxxx.DiagPercentage

xxxxxxx.Master-Slave Distance

xxxxxxx.RadioName

xxxxxxx.TemperatureF

xxxxxxx.EthernetMode

xxxxxxx.MasterPacketRepeat

xxxxxxx.Reflected Power

xxxxxxx.TurnOffDelay

xxxxxxx.FWVersion

xxxxxxx.MaxPacketSize

xxxxxxx.RepeaterFrequency

xxxxxxx.TurnOnDelay

xxxxxxx.FlowControl

xxxxxxx.MaxSlaveRetry

xxxxxxx.RetryOdds

xxxxxxx.TxSubNetID

xxxxxxx.FrequencyKey

xxxxxxx.MinPacketSize

xxxxxxx.RetryTimeOut

xxxxxxx.Voltage

xxxxxxx.Half/FullDuplex

xxxxxxx.MultiMasterSync

xxxxxxx.RfXmitPower

xxxxxxx.XmitRate

xxxxxxx.HighNoise

xxxxxxx.NetworkID

xxxxxxx.RxSubNetID

xxxxxxx.HopFreqOffset

xxxxxxx.NoiseJU

xxxxxxx.SignalInJU

Note: xxxxxxx represents the unique radio call number of each available radio.
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These 54 Tag's can be polled by OPC clients and used to update third party software that is capable of producing alarms and
other user defined functions. The server will report a Data Type, Value, and Quality as demonstrated in the figure below. If a
value is known the server will report a 'Good' quality however if the value is unknown to the server a value of '0' will be reported
along with a quality of 'Uncertain'. Keep in mind that not all values are supported by a master radio. A slave, or repeater radio
on the other hand will report values for all 54 Tag's.
An example of that is shown below:

Exiting LincView OPC
To close LincView OPC you can either,
Select Exit from the File menu.
Or
Click on the icon in the right hand corner of the window.
The LincView OPC window closes.
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Technical Support
Data-Linc Group maintains a fully trained staff of service personnel who are capable of providing complete product
assistance. They can provide you with technical, application and troubleshooting, spare parts and warranty assistance. Our
technical staff is based in Bellevue, Washington USA and may be reached at (425) 882-2206 or e-mail support@datalinc.com

Product Warranty
Data-Linc Group warrants equipment of its own manufacture to be free from defects in material and workmanship for one year
from date of shipment to original user. Data-Linc Group will replace or repair, at our option, any part found to be defective.
Buyer must return any part claimed defective to Data-Linc Group, transportation prepaid.

Return Material Authorization
If a part needs to be sent to the factory for repair, contact Data-Linc Group’s corporate office and request a Return Material
Authorization (RMA) number. The RMA number identifies the part and the owner and must be included with the part when
shipped to the factory.

Contact Information
Corporate Office
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Data-Linc Group
3535 Factoria Blvd. SE
Suite 100
Bellevue, Washington 98006 USA
Telephone: (425) 882-2206
Fax: (425) 867-0865
E-mail: info@data-linc.com
Web site: www.data-linc.com
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